USB AUDIO INTERFACE
AUDI OGRAM 6
Owner’s Manual
Bedienungsanleitung
Mode d’emploi
Manual de instrucciones
Руководство пользователя
取扱説明書
1. IMPORTANT NOTICE: DO NOT MODIFY THIS UNIT!
This product, when installed as indicated in the instructions contained in this manual, meets FCC requirements. Modifications not expressly approved by Yamaha may void your authority, granted by the FCC, to use the product.

2. IMPORTANT:
When connecting this product to accessories and/or another product use only high quality shielded cables. Cable/s supplied with this product MUST be used. Follow all installation instructions. Failure to follow instructions could void your FCC authorization to use this product in the USA.

3. NOTE:
This product has been tested and found to comply with the requirements listed in FCC Regulations, Part 15 for Class “B” digital devices. Compliance with these requirements provides a reasonable level of assurance that your use of this product in a residential environment will not result in harmful interference with other electronic devices. This equipment generates/uses radio frequencies and, if not installed and used according to the instructions found in the users manual, may cause interference harmful to the operation of other electronic devices. Compliance with FCC regulations does not guarantee that interference will not occur in all installations. If this product is found to be the source of interference, which can be determined by turning the unit “OFF” and “ON”, please try to eliminate the problem by using one of the following measures:
Relocate either this product or the device that is being affected by the interference.
Utilize power outlets that are on different branch (circuit breaker or fuse) circuits or install AC line filter/s.
In the case of radio or TV interference, relocate/reorient the antenna. If the antenna lead-in is 300 ohm ribbon lead, change the lead-in to co-axial type cable.
If these corrective measures do not produce satisfactory results, please contact the local retailer authorized to distribute this type of product. If you cannot locate the appropriate retailer, please contact Yamaha Corporation of America, Electronic Service Division, 6600 Orangethorpe Ave, Buena Park, CA90620
The above statements apply ONLY to those products distributed by Yamaha Corporation of America or its subsidiaries.

*(This applies only to products distributed by YAMAHA CORPORATION OF AMERICA.)*
## PRECAUTIONS

**PLEASE READ CAREFULLY BEFORE PROCEEDING**

* Please keep this manual in a safe place for future reference.

### WARNING

Always follow the basic precautions listed below to avoid the possibility of serious injury or even death from electrical shock, short-circuiting, damages, fire or other hazards. These precautions include, but are not limited to, the following:

<table>
<thead>
<tr>
<th>Do not open</th>
<th>Water warning</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Do not open the device or attempt to disassemble the internal parts or modify them in any way. The device contains no user-serviceable parts. If it should appear to be malfunctioning, discontinue use immediately and have it inspected by qualified Yamaha service personnel.</td>
<td>• Do not expose the device to rain, use it near water or in damp or wet conditions, or place containers on it containing liquids which might spill into any openings. If any liquid such as water seeps into the device, unplug the USB cable from this device immediately. Then have the device inspected by qualified Yamaha service personnel.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
</table>

Always follow the basic precautions listed below to avoid the possibility of physical injury to you or others, or damage to the device or other property. These precautions include, but are not limited to, the following:

<table>
<thead>
<tr>
<th>Location</th>
<th>Handling caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Before moving the device, remove all connected cables.</td>
<td>• When turning on the AC power in your audio system, always turn on monitor speakers LAST, to avoid speaker damage. When turning the power off, monitor speakers should be turned off FIRST for the same reason.</td>
</tr>
<tr>
<td>• Avoid setting all volume controls to their maximum. Depending on the condition of the connected devices, doing so may cause feedback and may damage the speakers.</td>
<td>• Do not insert your fingers or hands in any gaps or openings on the device.</td>
</tr>
<tr>
<td>• Do not expose the device to excessive dust or vibrations, or extreme cold or heat (such as in direct sunlight, near a heater, or in a car during the day) to prevent the possibility of panel disfiguration or damage to the internal components.</td>
<td>• Avoid inserting or dropping foreign objects (paper, plastic, metal, etc.) into any gaps or openings on the device.</td>
</tr>
<tr>
<td>• Do not place the device in an unstable position where it might accidentally fall over.</td>
<td>• Do not use the device for a long period of time at a high or uncomfortable volume level, since this can cause permanent hearing loss. If you experience any hearing loss or ringing in the ears, consult a physician.</td>
</tr>
<tr>
<td>• Do not use the device in the vicinity of a TV, radio, stereo equipment, mobile phone, or other electric devices. Doing so may result in noise, both in the device itself and in the TV or radio next to it.</td>
<td>• Do not rest your weight on the device or place heavy objects on it, and avoid use excessive force on the buttons, switches or connectors.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Connections</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Before connecting the device to other devices, turn off the power for all devices. Before turning the power on or off for all devices, set all volume levels to minimum.</td>
<td></td>
</tr>
</tbody>
</table>
Always unplug the USB cable from a computer or turn off the computer to turn off the device when the device is not in use.

The performance of components with moving contacts, such as switches, volume controls, and connectors, deteriorates over time. Consult qualified Yamaha service personnel about replacing defective components.

Specifications and descriptions in this owner's manual are for information purposes only. Yamaha Corp. reserves the right to change or modify products or specifications at any time without prior notice. Since specifications, equipment or options may not be the same in every locale, please check with your Yamaha dealer.

SPECIAL NOTICES

• This manual is the exclusive copyright of Yamaha Corporation.
• The included software is the exclusive copyright of Steinberg Media Technologies GmbH.
• Copying of the software or reproduction of this manual in whole or in part by any means is expressly forbidden without the written consent of the manufacturer.
• Yamaha makes no representations or warranties with regard to the use of the software and documentation and cannot be held responsible for the results of the use of this manual and the software.
• This disk containing the software is not meant for use with an audio/visual system (CD player, DVD player, etc.). Do not attempt to use the disk on equipment other than a computer.
• Future upgrades of application and system software and any changes in specifications and functions will be announced separately.
• The screen displays as illustrated in this manual are for instructional purposes, and may appear somewhat different from the screens which appear on your computer.

The illustrations and LCD screens as shown in this manual are for instructional purposes only, and may appear somewhat different from those on your instrument.

This product incorporates and bundles computer programs and contents in which Yamaha owns copyrights or with respect to which it has license to use others' copyrights. Such copyrighted materials include, without limitation, all computer software, music data, etc. Any unauthorized use of such programs and contents outside of personal use is not permitted under relevant laws. Any violation of copyright has legal consequences. DON'T MAKE, DISTRIBUTE OR USE ILLEGAL COPIES.

• Windows is a registered trademark of Microsoft® Corporation in the United States and other countries.
• Apple, Mac and Macintosh are trademarks of Apple Inc., registered in the U.S. and other countries.
• The company names and product names in this manual are the trademarks or registered trademarks of their respective companies.
Introduction

Thank you for choosing a Yamaha AUDIOGRAM 6 Computer Recording System. The AUDIOGRAM 6 includes a USB audio interface for digital audio data transfer, and Cubase AI DAW (Digital Audio Workstation) software for Windows® and Macintosh® computer operating systems. With the AUDIOGRAM 6 and your personal computer you have the basic elements of a high-performance computer recording system that is easy to set up and operate.

Please read through this manual carefully before beginning use, so that you will be able to take full advantage of your interface’s superlative features and enjoy trouble-free operation for years to come. After reading the manual, please store it in a safe place.

Contents

Introduction................................................................. 5
Contents ....................................................................................... 5
Features ....................................................................................... 6
Setup......................................................................................... 7
Quick Guide.............................................................................. 8
  1. Installing Cubase AI .................................................................8
  2. Connecting to the AUDIOGRAM interface .......................8
  3. Powering Up the System .........................................................9
  4. Adjusting Level .........................................................................9
  5. Recording with Cubase AI......................................................10
  6. Mixing with Cubase AI ............................................................14
Controls and Functions ........................................... 15
  Input Signal Flow ........................................................................16
Troubleshooting ....................................................... 17
Specifications ......................................................... 104
  General Specifications .............................................................104
  Dimensional Diagrams ..............................................................104
  Block Diagram and Level Diagram...........................................105
About the accessory disk .................................................. 106
Connect To Your Computer via a Single USB Cable (page 8)
The AUDIOGRAM interface connects to your computer via the supplied USB cable. Stereo audio data is transferred in both directions—from the interface to the computer, and vice-versa—via the USB connection (44.1 kHz or 48 kHz sampling frequency).

No Driver Installation Required (page 8)
The AUDIOGRAM system uses the standard drivers included in your computer’s operating system, so there's no need to install any extra driver software.

Cubase AI DAW Software Supplied (page 8)
Cubase AI software, included in the AUDIOGRAM package, offers versatile, high-performance hard-disk recording capability.

Compression (page 16)
Compression increases the overall level without introducing distortion by compressing excessive peaks in the signals from microphones and guitars.

48V Phantom Power (page 16)
A PHANTOM switch supplies +48V phantom power to the channel 1 microphone input, so you can use high-quality phantom-powered condenser microphones for superior recording quality.

Accessories
- Cubase AI DVD-ROM
- USB cable
- Owner’s Manual (this book)
Setup

Be sure to turn the PHANTOM +48V switch (★) on when using a phantom-powered condenser microphone.

To connect a device such as a microphone:

To connect an instrument such as an electric guitar or bass:

Computer

Cubase AI

USB cable

Powered speakers

Headphones

Computer

Cubase AI

USB cable

Powered speakers

Headphones

To connect a device such as a microphone:

To connect an instrument such as an electric guitar or bass:

MIC (ิน)

INST (อิน)

To connect a device such as a microphone:

To connect an instrument such as an electric guitar or bass:

MIC (ิน)

INST (อิน)
This quick setup and operation guide covers everything from installing the Cubase AI software to using Cubase AI for recording and mixdown. While going through this section you might find it useful to also refer to the “Controls and Functions” section on page 15, as well as the pdf manual supplied with the Cubase AI software.

**Step 1 Installing Cubase AI**

**Important!** You are only permitted to use this software pursuant to the terms and conditions of the “Steinberg Software End User License Agreement (EULA)” shown during the installation.

1. Start the computer and log on to the Administrator account.
2. Insert the included DVD-ROM into the computer’s DVD-ROM drive.
3. Follow the on-screen instructions to install the Cubase AI software.
   - In order to have continuous use of Cubase AI, including support and other benefits, you will need to register the software and activate your software license by starting it while the computer is connected to the Internet. Click the “Register Now” button shown when the software is started, then fill in all required fields for registration. If you do not register the product, you will be unable to use the application after a limited period of time expires.
   - To install on Mac computers double-click the “Cubase AI*.mpkg” icon or the “Cubase AI* Start Center” icon.
   - “*” indicates where the version number appears in the actual icon name.
   - Visit the web address below for the latest information on: [http://www.yamahasynth.com/](http://www.yamahasynth.com/)

**Step 2 Connecting to the AUDIOGRAM interface**

1. Turn all gear that is to be connected to the AUDIOGRAM off or to standby mode (except the computer), and set the LEVEL controls, MASTER LEVEL control and DAW control to their minimum settings.
2. Connect microphones and/or instruments. For details on making connections refer to the “Setup” section on page 7 and the “Controls and Functions” section on page 15.
3. Set the MIC/INST switch according to the type of device connected to channel 1 or 2. Select MIC (_MIC_) if a microphone is connected, or INST (INST) if a guitar or similar instrument is connected.
4. To use channels 1 and 2 as independent mono channels set the MONO/STEREO switch to MONO (MONO). To use channels 1 and 2 as a stereo pair set the switch to STEREO (STEREO).

Be sure to turn the PHANTOM +48V switch on when using a phantom-powered condenser microphone.
**Step 3** Powering Up the System

To prevent loud pops and noises, turn on the power to your sound gear starting with the sources (instruments, CD players, etc.) and ending with the monitor speakers (powered speakers).

1. **Turn on the instruments and microphones.**

2. If you are using a condenser microphone for the channel 1, turn on the PHANTOM +48V switch.

   Observe the following precautions when turning on phantom power.
   - Make sure that the PHANTOM +48V switch is off when phantom power is not needed.
   - When turning the switch on, be sure that only a condenser microphone is connected to the channel 1 MIC/INST input jack. Other devices may be damaged if connected to phantom power. This precaution does not apply to balanced dynamic microphones or instruments with the phone jack, however, as these will not be affected by phantom power.
   - To prevent damage to speakers, be sure to turn off power amplifiers (or powered speakers) before turning this switch on or off. We also recommend that you set the MASTER LEVEL control to the minimum position before operating this switch to avoid the risk of loud noises that could cause hearing loss or device damage.

3. **Connect the AUDIOGRAM interface to your computer using the supplied USB cable.**

   The POWER indicator will light to indicate that power is being applied to the AUDIOGRAM interface.

**USB Connection Precautions**

Be sure to observe the following points when connecting to the computer's USB interface. Failure to observe these rules can result in computer freezes/hang-ups and possibly data loss or corruption.

- Be sure to wake the computer from sleep/suspended/standby mode before making a connection to the computer's USB connector.
- Always quit all applications running on the computer before connecting or disconnecting the USB cable.
- Wait at least 6 seconds between connecting or disconnecting the USB cable.

**NOTE**

The first time you connect to the computer's USB connector, or change the connection to a different USB port, a driver installation display may appear. If this occurs, wait until the installation is complete before proceeding.

**Step 4** Adjusting Level

1. **Set the GAIN controls to the minimum position and the LEVEL controls to about 1 o’clock.**

   Set the MASTER LEVEL control to the minimum position. Failure to do so may result in loud noise bursts that can damage your equipment, your ears, or both.

2. **Adjust the volume on all instruments that are connected to the AUDIOGRAM interface.**

3. **Adjust the channel GAIN controls so that the corresponding PEAK indicators flash briefly on the highest peak levels.**

4. **Adjust the overall volume with the MASTER LEVEL control while monitoring via headphones or monitor speakers.**

   Lower the volume using the LEVEL controls until the level indicator PEAK LEDs flash only briefly on occasional high-level peaks or not at all.
Recording with Cubase AI

This section describes the procedure for recording to the Cubase AI software we installed earlier via the AUDIOGRAM interface.

Cubase AI Setup

1 Set the computer output to the maximum level.
   For details on how to make the setting refer to the “The recorded sound is too low in level.” section in the “Troubleshooting” on page 17.

2 Launch Cubase AI.

   Windows:
   Click [Start] → [All Program] → [Steinberg Cubase AI *] → [Cubase AI *] to launch the program. (“*” indicates where the version number appears in the actual icon name.)
   NOTE If the ASIO Direct Sound Full Duplex Driver dialog window appears, click [OK].

   Mac:
   Double-click the [Application] → [Cubase AI*]. “*” indicates where the version number appears in the actual icon name.
   • If you specified a file destination when installing the Cubase AI software, launch the application from that location.
   • Create a Cubase AI shortcut or alias on your desktop so you can easily launch the program when required.

3 When the Project Assistant window appears, select the [More] menu→[Empty] and click [Create].

   A new project is created.
   NOTE Recorded Cubase AI data is stored as a “Project.”

4 Select [Device Setup] from the [Devices] menu to open the Device Setup window.

   Windows:
   Select [VST Audio System] in the [Devices] field on the left side of the window. Select [ASIO DirectX Full Duplex Driver] in the [ASIO Driver] field on the right side of the window. A dialog box will appear asking “Do you want to switch the ASIO driver?” Click [Switch].

   Mac:
   Select [VST Audio System] in the [Devices] field on the left side of the window. Select [USB Audio CODEC] in the [ASIO Driver] field on the right side of the window. A dialog box will appear asking “Do you want to switch the ASIO driver?” Click [Switch].
5 Select [ASIO DirectX Full Duplex Driver](Windows), [USB Audio CODEC](Mac) in the [Devices] field on the left side of the Device Setup window, and click [Control Panel] on the right side of the window.

Windows:
The ASIO Direct Sound Full Duplex Setup dialog box will be displayed. Check only the input port and output port [USB Audio CODEC] checkbox, and then click [OK] to close the dialog window.

Mac:
The [CoreAudio Device Settings] dialog window appears. Check only the [USB Audio CODEC] checkbox in both "Input" and "Output" of the [Input/Output Configuration] field. Click [Close] to close the dialog window.

6 Make sure that “USB Audio CODEC 1/2”(Windows), “Front Left/Front Right” (Mac) are shown in the [Port System Name] field, and check the [Visible] column in the Device Setup window. Click [OK] to close the window.

NOTE
If the [Port System Name] field does not change, close and restart the Cubase AI, then open the Device Setup window.

7 Select [VST Connections] from the [Devices] menu.

Windows:
If “Not Connected” is selected in the [Audio Device] field, click on the “Not Connected” indication, and then switch to [ASIO DirectX Full Duplex Driver]. Also set the [Outputs] in the same way, and then close the window.

Mac:
If “Not Connected” is selected in the [Audio Device] field, click on the “Not Connected” indication, and then switch to [USB Audio CODEC]. Also set the [Outputs] in the same way, and then close the window.

8 Select [Add Track] → [Audio] from the [Project] menu.
The Add Audio Track dialog window appears.

9 Set the “Count” and “Configuration” parameters, and then click [Add Track].

The added tracks will appear.

NOTE
You will normally use a stereo track when recording synthesizers, and a monaural track when recording vocals or guitars.
Preparing to Record

1 Click in the track list (the area in which the track names are displayed) to select a track to record on.
   The various settings for the selected track are available in the Inspector on the left side of the display.

2 Make sure the [Record Enable] button for the track to be recorded is turned on.
   If the [Record Enable] button is off, click it to turn it on.

3 Play the instrument to be recorded, and adjust the AUDIOGRAM GAIN controls and LEVEL controls so that the Clipping indicator never lights.

4 Specify the point at which you want to start recording via the ruler at the top of the window for the project.
   Click the black area of the ruler to move the project cursor (the vertical black line) to that position.
Recording and Playback

1 Click the Transport panel [Record] button to begin recording.
   When recording is started the project cursor will begin moving to the right and a box that displays the recording results will be created.

   <Transport panel>

   1. 1. 1. 0

   Rewind  Record  Forward  Stop

2 Play the part.

3 When you finish recording the track, click the Transport panel [Stop] button.
   To hear playback of the track you have just recorded, use either the Transport panel [Rewind] button or the ruler to rewind to the beginning of the recorded section, then click the Transport panel [Start] button.

4 Select [Mixer] from the [Devices] menu to open the Mixer window.
   The overall playback level will be displayed via the master section bus level meter on the right side of the mixer window, and the channel level will be displayed via the channel strip level meter.

   NOTE: To hear the playback sound via the AUDIOGRAM interface, adjust the volume with the DAW control and MASTER LEVEL control. The playback level will approximately match the recording level when the DAW control is set to about 1 o’clock.

5 To save the project select [Save] from the [File] menu and enter a file name before actually saving the file.
   Save your project frequently to insure against losing large amounts of data if a problem occurs.

6 Repeat steps 1 through 5 to record further material on the same track.

7 To record additional material on a different track, select a new track and repeat the record procedure.

Recording with maximum quality and minimum noise:

For optimum sound quality with minimum noise, the AUDIOGRAM signal levels should be set as high as possible without clipping. Check signal levels to be sent to Cubase AI for recording using the AUDIOGRAM level indicators while the DAW control is set to minimum. Adjust the channel LEVEL controls so that the corresponding PEAK LEDs flash only occasionally on the highest input transients.
In this section we’ll try mixing down multiple recorded audio tracks to stereo, and creating an audio file. Mixes can be stored as WAV or AIFF files, which can then be recorded to audio CDs.

1. Launch Cubase AI and open a project file.
2. Click the [Start] button on the Transport Panel.
3. While listening to playback, drag the channel strip level faders up and down to create the desired initial balance, then adjust the overall volume using the bus volume fader.
4. Drag the pan controls on the top of the channel strips left and right to set the stereo position of each track.

5. At this point you can begin to use EQ to refine your mix, and add effects.

As an example let’s try adding reverb. Click the [Edit] button ( ) on the left side of the channel strip to open the VST audio channel settings window. Click Inserts 1 and select “Reverb - RoomWorks SE.”

6. Double-click the left locator (starting point) and right locator (ending point) of the Transport panel. Change each highlighted number, and then specify the position of the locator.

7. When the final mix adjustments have been made, go to the [File] menu and select [Export] → [Audio Mixdown].

8. Enter a file name and select a destination for the file as well as a file type.

If you intend to use the file to create an audio CD, select the WAV file type (AIFF on Mac OS X), 44.1 kHz, and 16 bit.

9. Click [Export].

Progress of the mixdown operation will be shown in a progress window. When the progress window closes the mixdown is complete.

Notes:
- Files created by mixdown can be directly played back using the Windows Media Player, or iTunes.
- It’s a good idea to lower the channel fader a bit before adding an effect, since the effect can cause an increase in the overall channel level.
Controls and Functions

1 MIC/INST Input Jack
Microphones and instruments such as guitars can be connected here using XLR or phone jack cables. Set the MIC/INST switch to MIC or INST according to the type of device connected.

- **XLR-type**
- **Phone-type**

**NOTE** You can directly connect an electric guitar or bass without the need for a separate DI (Direct Injection) box or amp simulator.

2 LINE Input Jacks (L (MONO)/R)
These inputs are intended mainly for use with instruments and equipment having stereo outputs, such as a synthesizer or CD player.

If you connect to the L (MONO) jack only, the AUDIOGRAM will recognize the signal as monaural and will send the identical signal to both the L and R jacks.

- **Phone-type**

3 STEREO OUT Jacks
These output the mixed signal from channels 1 to 5/6. The output level can be adjusted using the MASTER LEVEL control. These jacks would typically be connected to monitor speakers (powered speakers).

4 PHONES Jack
Connects a pair of headphones to this jack. The PHONES jack outputs the same signal as the STEREO OUT jacks.

5 MIC/INST Switch
Set this switch according to the type of device connected. Select MIC ( ) if a microphone is connected, or INST ( ) if an electric guitar or bass is connected.

**NOTE** If a device is not connected to the MIC/INST jack, set this switch to MIC ( ). Otherwise noise may occur.

6 GAIN Control
Adjusts the input signal level. To achieve the best balance between S/N ratio and dynamic range, adjust the level so that the input channel PEAK indicator lights only occasionally and briefly on the highest input transients.
COMP Control
Adjusts the amount of compression applied to the channel. As the knob is turned to the right, the interface automatically raises the compression ratio while adjusting the output gain accordingly. The result is smoother, more even dynamics because louder signals are attenuated while the overall level is boosted.

NOTE
Avoid setting the compression too high, as the higher average output level that results may lead to feedback.

MONO/STEREO Switch
This switch allows channels 1 and 2 to be used either as separate mono channels or as a stereo pair. When set to MONO ( ), channels 1 and 2 function as independent mono channels feeding both the L and R STEREO OUT jacks 3. When set to STEREO ( ), input channels 1 and 2 function as a stereo pair: the channel 1 signal feeds the L STEREO OUT jack and the channel 2 signal feeds the R STEREO OUT jack.

PEAK Indicators
The PEAK indicators light when the channel signal reaches or exceeds clipping level. Note that signal levels as indicated by the PEAK indicators are affected by both the GAIN and LEVEL controls.

If a PEAK indicator lights, adjust the GAIN 6 and COMP 7 controls to lower the level so that the indicator goes out.

LEVEL Controls
Adjusts the level of the channel signal. Use these controls to adjust the balance between the various channels.

POWER Indicator
This indicator lights when power is applied to the AUDIOGRAM interface via the USB cable (supplied) that connects it to the computer.

PHANTOM +48V (CH1) Switch/Indicator (only for channel 1)
This switch toggles phantom power on and off. If you set the switch on ( ), the AUDIOGRAM supplies phantom power to channel 1 MIC/INST jack (XLR-type) 1. Turn this switch on when using a phantom-powered condenser microphone.

NOTE
Be sure to leave this switch off ( ) if you do not need phantom power.

When turning the switch on, be sure that only a condenser microphone is connected to the channel 1 MIC/INST input jack. Other devices may be damaged if connected to phantom power. This precaution does not apply to balanced dynamic microphones or instruments with the phone jack, however, as these will not be affected by phantom power.

To prevent damage to speakers, be sure to turn off power amplifiers (or powered speakers) before turning this switch on or off. We also recommend that you set the MASTER LEVEL control to the minimum position. Neglect of these precautions may result in large noise bursts that may damage your equipment, your ears, or both.

Level Indicators
These indicators show signal levels prior to the MASTER LEVEL control 15. The SIGNAL LED lights when a signal is present, and the PEAK LED lights when the signal reaches or exceeds clipping level. Adjust the input channel LEVEL controls 7 so that the PEAK LEDs flash only briefly on occasional high-level peaks or not at all.

DAW Control
Adjusts the level of the signal received from Cubase AI sent to the AUDIOGRAM STEREO OUT jacks 3.

MASTER LEVEL Control
Adjusts the signal level sent to the STEREO OUT jacks 3. This allows you to adjust the overall volume without changing the relative volume balance among the channels.

USB Connector
Connects the AUDIOGRAM interface to a USB port on your computer via the supplied USB cable. In addition to transferring audio data between the AUDIOGRAM interface and the computer, the USB cable supplies power from the computer to the AUDIOGRAM interface.

When connecting or disconnecting the USB cable be sure to turn the DAW control and the MASTER LEVEL control all the way down.

NOTE
Yamaha recommends that you use a USB cable with a length of 1.5 meter or less.

---

### Input Signal Flow

- **Input**
  - Adjust for maximum level with minimum noise.

- **GAIN controls**
  - Adjust the recording level as well as the balance between channels.

- **COMP controls**
  - Compress the signal for increased subjective level.

- **DAW control**
  - Adjusts the level of the signal received from Cubase AI sent to the AUDIOGRAM STEREO OUT jacks 3.

- **MASTER LEVEL control**
  - Adjusts the signal level sent to the STEREO OUT jacks 3.

- **Level indicator**
  - Adjusts the monitor level.

- **Record**
  - Adjusts the playback level from Cubase AI (does not affect the record level).

- **Output**
  - Adjusts the playback level from Cubase AI (does not affect the record level).
Troubleshooting

The AUDIOGRAM interface won’t turn on.
❑ Is the included USB cable properly plugged into the interface and a computer?

The system doesn’t work properly.
❑ Are the USB cable and all necessary audio cables properly connected?
❑ Are you using a USB hub?
   USB hubs can interfere with proper operation, so try connecting the AUDIOGRAM interface directly to a USB port on the computer. If the computer has multiple USB ports, try a different USB port.
❑ Are you using other USB devices at the same time?
   If so, try removing the other device(s) and connecting only the Yamaha USB device.

The Input ports are not shown (Windows 7/Vista)
❑ Is the sound input of your computer operating system assigned properly?
  1. From the [START] menu click [Control Panel], then double-click the “Sound” icon to open the “Sound” dialog window.
  2. Click the “Recording” tab, right-click the “USB Audio CODEC” icon and select “Properties.”
  3. Click the “Advanced” tab, then select “2 channel, 16 bit, 44100 Hz (CD Quality)” or “2 channel, 16 bit, 48000 Hz (DVD Quality)” in the “Default Format” field.

No sound.
❑ Are your speaker cables connected properly, or are they shorted?
❑ Are the volume controls of your sources, audio devices, applications software, computer operating system, etc., set at appropriate levels?
❑ Is the output of your computer operating system muted?
❑ Do you have several applications running at the same time?
   Be sure to quit all applications you are not using.
❑ Is the sound output of your computer operating system assigned properly?

Windows 7/Vista:
1. From the [START] menu click [Control Panel], then double-click the “Sound” icon to open the “Sound” dialog window.
2. Click the “Recording” tab and check whether the “USB Audio CODEC” icon is checked.
   If not, right-click the “USB Audio CODEC” icon and select “Set as Default Device.”
3. Click the [Recording] tab and check whether the “USB Audio CODEC” icon is checked.
   If not, right-click the “USB Audio CODEC” icon and select “Set as Default Device.”

Mac:
1. Select “System Preferences ...” from the Apple menu and then select “Sound” to open the “Sound” dialog window.
2. Click the “Input” tab and under “Choose a device for sound input” select “USB Audio CODEC”.
3. Click the “Output” tab and under “Choose a device for sound output” select “USB Audio CODEC”.

Windows XP:
1. From the [START] menu click [Control Panel], then double-click the “Sounds and Audio Devices” icon to open the “Sounds and Audio Devices Properties” dialog window.
2. Click the “Audio” tab.
3. Set “Sound playback: Default device” and “Sound recording: Default device” to “USB Audio CODEC.”
4. Click [OK].

The recorded sound is too low in level.
❑ Is the computer’s output level setting too low?
   We recommend that you set the computer output to the maximum level and mute the computer’s internal speaker.

Windows 7/Vista:
1. From the [START] menu click [Control Panel], then double-click the “Sound” icon to open the “Sound” dialog window.
2. Click the “Playback” tab, right-click the “USB Audio CODEC” icon and select “Properties.”
3. Click the “Levels” tab, then set the volume slider to its maximum level.
   Close the “Properties” dialog window.
4. Click the “Sounds” tab in the “Sound” dialog window, then select “No sounds” in the “Sound Scheme.”

Windows XP:
1. From the [START] menu click [Control Panel], then double-click the “Sounds and Audio Devices” icon to open the “Sounds and Audio Devices Properties” dialog window.
2. Click the “Volume” tab.
3. Set “Device volume” to “High.”
4. Click the “Sound” tab.
5. Select “No sound” in the “Sound scheme.”
Troubleshooting

Mac:
1. Select [System Preferences ...] from the Apple menu and then select “Sound” to open the “Sound” dialog window.
2. Click the “Output” tab and set the volume slider at the bottom of the window to its maximum level.
3. Click the “Sound Effect” tab and set the volume slider of the “Alert volume” slider to its minimum level.

❑ Have you connected or disconnected the USB cable while Cubase AI is running?
   Doing so can sometimes cause the Windows output level to be reset to its default level. Check and raise the output level if necessary.

The sound is intermittent or distorted.
❑ Is the PEAK indicator flashing red?
   You might have to lower GAIN or LEVEL control levels to avoid distortion.
❑ Are you applying the compressor at an appropriate level?
   You might have to lower COMP control levels.
❑ Are any other applications, device drivers, or USB devices (scanners, printers, etc.) running at the same time?
   Be sure to quit all applications you are not using.
❑ Are you playing back a large number of audio tracks?
   The number of tracks you can play at the same time will depend on the performance of the computer you are using. You may experience intermittent playback if you exceed your computer’s capabilities.
❑ Are you recording or playing long continuous sections of audio?
   The audio data processing capabilities of your computer will depend on a number of factors including CPU speed and access to external devices.

On Windows XP computers, changing some settings as outlined below can improve performance.
1. Click [Control Panel] from the [START] menu, and double-click the “Sounds and Audio Devices” icon to open the “Sounds and Audio Devices Properties” dialog window.
2. Click the “Volume” tab and click “Advanced” in “Speaker settings.” The “Advanced Audio Properties” dialog window will open.
3. Click the “Performance” tab. Set “Hardware acceleration” to “Full”, and “Sample rate conversion quality” to “Good.”

Don’t change these settings if you are not familiar with your computer’s operating system.
Check that the file system is set properly, and make sure that you have a plenty of free memory (more than 128 megabytes). If the audio files you are recording or playing are not too large, changing the virtual memory settings can sometimes improve audio performance.
In some cases it might be necessary to update your hard disk controller, device drivers, or BIOS. Refer to your computer’s support center or support page on the web for more information.
❑ Try adding memory.
   Adding more RAM memory can significantly increase your computer’s audio performance. Refer to your computer’s owner’s manual for information on installing and setting up extra memory.

There is a delay when playing a software synthesizer via a MIDI keyboard (latency).
❑ Check the URL listed below for the latest information.
   <http://www.yamahasynth.com/>
Specifications

■ General Specifications

<table>
<thead>
<tr>
<th>Jacks</th>
<th>MIC/INST Input Jack</th>
<th>x 2</th>
<th>Combo jacks (Mic/HiZ)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>LINE Input Jacks (L, R)</td>
<td>x 2</td>
<td>Phone jacks</td>
</tr>
<tr>
<td></td>
<td>PHONES Jack</td>
<td>x 1</td>
<td>Phone jack</td>
</tr>
<tr>
<td></td>
<td>STEREO OUT Jacks (L, R)</td>
<td>x 1</td>
<td>Phone jacks</td>
</tr>
<tr>
<td></td>
<td>USB Connector</td>
<td>x 1</td>
<td>USB 1.1 44.1/48 kHz, 16 bit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Controls</th>
<th>MIC/INST Switch</th>
<th>x 2</th>
<th>MIC: for microphones INST (Hi-Z): for guitars, etc.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>GAIN Control</td>
<td>x 4</td>
<td>Gain for CH 1-5/6</td>
</tr>
<tr>
<td></td>
<td>COMP Control</td>
<td>x 2</td>
<td>Compressor for CH 1, 2</td>
</tr>
<tr>
<td></td>
<td>MONO/STEREO Switch</td>
<td>x 1</td>
<td>MONO: CH 1, 2 signals function as independent mono channels. STEREO: CH 1, 2 signals function as a stereo pair.</td>
</tr>
<tr>
<td></td>
<td>LEVEL Control</td>
<td>x 4</td>
<td>Adjust the level of CH 1-5/6</td>
</tr>
<tr>
<td></td>
<td>PHANTOM +48V Switch</td>
<td>x 1</td>
<td>48 V, only for CH1</td>
</tr>
<tr>
<td></td>
<td>DAW Control</td>
<td>x 1</td>
<td>Adjusts the DAW playback signal</td>
</tr>
<tr>
<td></td>
<td>MASTER LEVEL Control</td>
<td>x 1</td>
<td>Adjusts the overall signal</td>
</tr>
</tbody>
</table>

| Indicators | Level Indicators | x 1 | 2 points (green, red) |
|            | PEAK Indicator | x 4 | Red |
|            | Phantom Power | x 1 | Red |
|            | Power | x 1 | Green |

| Power Supply | USB bus-powered |
| Dimensions (W x H x D) | 170 x 59 x 192 mm |
| Net Weight | 760 g |
| Included Accessories | Cubase AI DVD-ROM USB cable Owner's Manual |

■ Dimensional Diagrams
**Block Diagram and Level Diagram**
About the accessory disk

SPECIAL NOTICE

• The software included in the accessory disk and the copyrights thereof are under exclusive ownership by Steinberg Media Technologies GmbH.
• Copying of the software or reproduction of this manual in whole or in part by any means is expressly forbidden without the written consent of the manufacturer.
• Yamaha makes no representations or warranties with regard to the use of the software and documentation and cannot be held responsible for the results of the use of this manual and the software.
• This disk is NOT for audio/visual purpose. Do not attempt to play the disk on an audio/visual CD/DVD player. Doing so may result in irreparable damage to your player.
• Note that Yamaha does not offer technical support for the DAW software in the accessory disk.

About the DAW software in the accessory disk

The accessory disk contains DAW software both for Windows and Mac.

NOTE
• Make sure to install DAW software under the “Administrator” account.
• In order to have continuous use of the DAW software in the accessory disk, including support and other benefits, you will need to register the software and activate your software license by starting it while the computer is connected to the Internet. Click the “Register Now” button shown when the software is started, then fill in all required fields for registration. If you do not register the software, you will be unable to use it after a limited period of time expires.
• To install on Mac computers double-click the “Cubase Al*.mpkg” icon or the “Cubase AI* Start Center” icon.
• “*” indicates where the version number appears in the actual icon name.

For information about the minimum system requirements and latest information on the software in the disk, check the web site below.
<http://www.yamahasynth.com/>

About software support

Support for the DAW software in the accessory disk is provided by Steinberg on its website at the following address.
http://www.steinberg.net

You can visit the Steinberg site also via the Help menu of the included DAW software. (The Help menu also includes the PDF manual and other information on the software.)
For details of products, please contact your nearest Yamaha representative or the authorized distributor listed below.

Please do not touch the products, see appendix for the list of products.

For more details on products, please contact your nearest Yamaha representative or the authorized distributor listed below.

Die Einzelheiten auf die Produkte sind bei Ihrer unten aufgeführten Niederlassung oder bei Ihnen vertretenden in den jeweiligen Bestimmungsländern erhältlich.

Pour plus de détails sur les produits, veuillez-vous adresser à Yamaha ou au distributeur le plus proche de vous figurant dans la liste suivante.